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About ShareStream
ShareStream allows instructors to take advantage of the educational potential of online multimedia for
teaching and learning. Using ShareStream, you can enhance your Blackboard Learn™ Learning
Management System (LMS) with an easy-to-use solution for streaming video and audio content and
manage the multimedia content for your course.
ShareStream allows you to:





Upload video and audio files.
Tag content with metadata that your students can view while playing the media assets assigned
to them for your course.
Organize the media for your course into folders that correspond to your syllabus.
Receive media created by your students for course assignments, and add student media to your
course collection.

ShareStream, which is conveniently accessible right within your Blackboard Learn window, provides two
primary options for presenting course media to students enrolled in a course:




Display a single “hub” for your course’s media within the Blackboard Learn platform through
ShareStream Pick-n-Play®, an intuitive YouTube-like application that is accessible directly from
the Blackboard Learn interface. Using Pick-n-Play, instructors and students can access, play and
collaborate on all of the video and audio content for a particular course.
Display course-media assets directly from a Blackboard Learn course web page through
ShareStream’s Media Publishing Tools, which allow you to easily add media to a specific location
in a Blackboard Learn page.

ShareStream is closely integrated with the Blackboard Learn technology, the Learning Management
System at your institution. This means that you can incorporate media stored in ShareStream into your
Blackboard Learn course pages and student assignments.

Get Started with ShareStream
To get started, you will first need to create a ShareStream Course Collection and upload your media
assets into ShareStream. By “media asset,” we are referring to video and audio files, which can be
uploaded into ShareStream, added to your course, and played by the students enrolled in your course.
Here are the basic steps for getting started with ShareStream:
1. First, create a course collection to store your media assets in. See Create Your Course Collection
below.
2. Next, upload media and add it to your course collection. See Add Media to Your Course on
page 3.
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As soon as you have added your media to your course, your students and other members of the
course—other instructors for this course, for example—will be able to view your media assets.

Create Your Course Collection
To begin using ShareStream, you must first create a ShareStream Course Collection—a location in
ShareStream to store and manage the media assets for your course.
Depending on how ShareStream is administered at your institution, you may be able to create a course
collection automatically from your Blackboard Learn interface:



If your institution has enabled the ShareStream Auto-Course Creation capability, you can create
a course collection automatically from the Blackboard Learn window.
If Auto-Course Creation is not enabled, you will see a message saying that your course does not
have a corresponding Course Collection in ShareStream. If this message appears, you will need
to ask your institution’s ShareStream system administrator to create a Course Collection for you.

Provided that your institution has Auto-Course Creation enabled, you can click on the course link on
your Blackboard Learn home page, after which your ShareStream Course Collection will be automatically
created for you.
To create a Course Collection:
1. Click on the Course link on your Blackboard Learn home page to go to the Course Home Page for
a course for which you are the instructor.
2. On the Course Page, go to the course menu.
3. Click Tools in the course menu.
4. On the Tools page, click ShareStream Pick-n-Play.
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5. As soon as you click on this link, your ShareStream Course Collection is automatically created,
and the ShareStream Pick-n-Play application will open within your Blackboard Learn window.

ShareStream Pick-n-Play opens on the Course Collection tab, where your media will appear once you
have uploaded media and added it to your Course Collection.
Note: If ShareStream does not appear in your Blackboard Learn window, you may need to enable thirdparty cookies in your browser. Certain browsers have third-party cookies disabled by default. Go to your
browser’s privacy settings and check the option to enable third-party cookies, or allow an exception for
ShareStream. See the documentation for your browser for instructions.

Add Media to Your Course Collection
Now that you have created a ShareStream Course Collection, you will upload your media into
ShareStream, and then add the media to your Course Collection.

Upload Media
To upload your media, you will go to the My Workspace page in ShareStream Pick-n-Play.
My Workspace is a personal storage location for instructor media. Your media is only viewable by you
when it is in My Workspace; it is not viewable by students or other users with privileges to your course.
After you have added the media assets in My Workspace to your Course Collection page, the media
assets will be viewable by students and other users with privileges to your course.
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To upload a media asset into ShareStream:
1. Click on the My Workspace tab.

2. Click on Upload Media, either the large button to the left of the media player, or the menu
option at the top of the My Workspace tab.
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The Upload popup window opens prompting you to select your media asset.

3. Do one of the following:
 Click on the Drop/Click to Select Media File button, and browse to locate and select the
media asset on your computer’s file directory.
 Drag and drop a media asset onto the Drop/Click to Select Media File button. Note: Drag
and drop is not currently supported in the Internet Explorer browser.
4. Enter information about this media asset: the Title, Contributor (you can check “Me” as the
Contributor), and Description.
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5. Click on Add Media.

A progress bar provides you with real-time feedback on the progress of the upload.
6. When the media asset is finished uploading, you will see a prompt to upload more files.
Click No for now, to go to the next step with your first media file.
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7. A “Processing” icon appears in the My Workspace gallery until the file is ready for your use.

When the file is available, the “Processing” icon will be replaced with a thumbnail of the media asset
you have just uploaded. Your media asset is now uploaded to the My Workspace tab, where you can
prepare your media asset for your students before adding it to your course collection.

Note: You can always return to My Workspace to add more media assets and perform other tasks in
preparation for adding your media assets to your Course Collection. See Use the My Workspace Tab on
page 24 for a more in-depth description of the features provided in My Workspace.
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Add to Course
Now that you have uploaded your media asset to your My Workspace page, your next step is to add the
media asset to your Course Collection. To accomplish this, please follow the steps below:
1. On the My Workspace tab, select the checkbox next to the thumbnail for your media asset.
2. Click on Add to Course.

A dialog box opens for you to select a folder destination in your Course Collection.
3. Select the folder you would like to add the media asset to, and then click Done.

Note: As you are just getting started with ShareStream and have not set up a directory
structure with folders within your Course Collection, you have only one folder for your Course
Collection.
Later on, you can create folders and subfolders to organize your course media into a folder
directory. After you have created a folder directory for your course media, you will be able to
send media assets from your My Workspace page to a specific folder in your Course Collection.
4. You will see a confirmation message when the file is added. Click the X to close the popup
window.
5. Click on the Course Collection tab, and you will see the media asset you have added to the
Course Collection.
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Note: You may see a placeholder thumbnail while the media asset is still processing.

When the media asset has completed, you will see it in your Course Collection. Unlike your My
Workspace page, which is only viewable by you, the Course Collection page is available to all users with
privileges for your course.

You have now completed the basic steps to upload media assets into ShareStream and add your media
assets to your course collection. Next, you will learn how to play, browse and collaborate with students
on the media assets in your Course Collection.
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Use the Course Collection Tab
On the Course Collection tab, you can play media, search and filter to find the media assets you would
like to play, set your display options, and use the Dropbox. Below is an overview of the features
provided in the Course Collection tab.

In the following sections, you can find information on how to use the features in the Course Collection
Tab, including:








Media Player – Play media, add metadata, and share media files. See Use the Media Player on
page 12.
View Thumbnails or List – Choose how to display the media in your Course Gallery. See View Media
as Thumbnails or in a List on page 13.
Filter Menu – Choose the criteria for the media assets you would like to display in your Course
Gallery, such as Video Only, Recently Added, etc. See Filter the Course Media Gallery on page 14.
Course Gallery –Displays the media assets currently in your course collection or the media assets
that match the filters or searches you have performed.
Search – Quickly find media assets in your Course Collection. See Search for Media on page 20.
Show/Hide Course Folders – Select whether to display or hide the subfolders in your Course
Collection. See Show or Hide Folders on page 23.
Dropbox – Enable students and other faculty members in the same course to exchange media that
you receive in your Media Inbox. See Use the Dropbox on page 33.
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Select Media to Play
You can play media assets any of the following ways:


Click on the Play icon in the asset’s thumbnail.



Click on the name of the media asset.



Click on the Action menu for the media asset, and select Play.
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The media asset begins to play in the Pick-n-Play Media Player.

Use the Media Player
You can use the following controls on the Pick-n-Play Media Player.






Play Button – Click to Play the media file.
Progress Bar – Shows the progress of the media asset that is currently playing. You can click and
drag this control to go to a specific point in the media asset.
Time Elapsed/Total Time – Shows the time progress of the playing file, and the total duration of
the file.
Mute Microphone – Click to mute or un-mute the file.

©Copyright 2013 ShareStream

12

Page 12

ShareStream Instructor’s Guide










Volume Control – Click and drag to increase or decrease the sound volume.
Closed Captioning – Click to turn on closed captioning to display subtitles designed for student
accessibility. Note: you must first upload a closed-caption file for the media asset for closed
captioning to be enabled. See Upload Closed-Caption Files on page 55.
Screen Control – Click to increase the size of the player to full-screen.
Title of File – Shows the title as entered into ShareStream.
Share Video – Click to select options for sharing the asset in the media player. Note: To ensure
that only users enrolled in your course can access course media, media assets shared using the
“Share Video” feature will ask the user to authenticate before the media asset is played.
More Info – Click to view metadata information about the media file.

View Media as Thumbnails or in a List
On the Course Collection or My Workspace tabs, you can toggle between viewing all media assets in a
thumbnail-gallery view or in a list view by selecting Thumbnails or List in the View menu.

The following screenshots show example Thumbnail and List views.

Example Thumbnail View

Example List View

Set Featured Media
You can select a media asset as “Featured,” which means it will appear for the users enrolled in your
course as the initial asset displayed in the playback window on the Course Collection page.
To select featured media:
1. Select the media asset.
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2. On the Action menu, click Make Featured.

Then the media asset you selected as Make Featured will appear on the Course Collection page.

Filter the Course Media Gallery
On the Course Collection tab, you can select filter options to help identify the course media assets you
would like to play and work with. This is helpful if a course has a large number of media assets, or if you
just want to view assets of a specific media type (for example, only videos), or recently added or viewed
media.
1. To filter the display, click the Filter drop down menu as shown in the following screenshot.
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2. Then, select the option to filter by: Favorites, Video Only, Audio Only, Recently Added, etc.

The filtered result shows in the Course Collection tab.

Add Media to Your Favorites
You can mark a media asset as a Favorite, which is similar to a personal playlist of the media assets in
your Course Collection. Then, when you filter to Favorites in the drop-down menu, only those items you
have marked with a Favorite star will appear.
The Favorites feature allows you to keep track of your most important media assets, or the media assets
that are most relevant to your course at a particular point in time. For example, you might select an
asset as a Favorite to keep track of a media asset that you are planning to use for an upcoming lecture.
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To use favorites:
1. Select a media asset.
2. Click the star icon that appears next to a media asset. The star icon will become yellow to show
that you’ve selected the item as a favorite.

Then, from the Filter drop down menu, you can select Show Favorites to display only the media assets
you have added to your Favorites.

Use Metadata
The term “metadata” refers to information about a media asset. Your students will be able to view the
metadata you have entered about your media assets while playing the asset. Certain metadata fields in
ShareStream are required fields: the Title, Contributor, and Description. You can view and edit
metadata for each media asset in your Course Collection.
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View Metadata
To view metadata about a media asset, select one of the following options:


Click the More Info link in the Media Player.

 Or, select the media asset in the thumbnail or list view, and on the Action menu, click
Information.
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The Metadata popup window opens.

Add or Edit Metadata
To edit the metadata for media:
1. Select the media asset.
2. Click on the Action menu, and then click on Information. Or, click on the More Info link below
the Media Player.
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The Metadata popup window opens.
3. Click the Edit tab.

4. On the Edit tab, edit the fields as necessary, and then click Done.

Download Media
Certain media assets in ShareStream can be downloaded and saved to your computer. Note: for
security purposes, you will only be able to download an asset if the asset’s metadata in ShareStream
MediaManager has been checked as “Downloadable” and a downloadable version of the file has been
uploaded into ShareStream.
To download a course media asset to your system:
1. Select a media asset.
2. On the Action menu, click Download. You will then be prompted to open or save the file on
your system.
For information on how to upload media that can be downloaded, see Upload Media as Downloadable
on page 51.

Play Podcasts
From the Pick-n-Play application, downloadable media can be distributed to users enrolled in your
course through podcasts. Note: for security purposes, you will only be able to podcast an asset if the
asset’s metadata in ShareStream MediaManager has been checked as “Downloadable.”
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To access a podcast from the Course Collection page in Pick-n-Play:
1. Click on a podcast.
2. In the Launch Application dialog box, select an application to play the podcast, typically iTunes.
Podcasts will require the viewer to login with his or her username and password. After the user has
authenticated, the podcast is then downloaded to the viewer’s iTunes or other application. The viewer
can then play the podcast in iTunes on his or her computer, or sync the podcast to a mobile device.
For information on how to upload podcasts, see Upload Podcasts on page 53.

Search for Media
You can easily search for media assets in the Pick-n-Play interface. Please note that the search will only
be performed for the Pick-n-Play page that you are currently on. For example, if you are in the Course
Collection tab, all media assets stored in your course collection will be searched, but not the media
assets in your My Workspace page. Also, if you have a filter selected, only the filtered media assets will
be searched.
On the Course Media page, simply type your search string in the Search text box, and then click Search.

Note: To list all assets again (subject to any filters that you have set in the Filter Menu), click Clear
Results.

Organize Your Media in the Course Collections Page
Within Pick-n-Play, you can move, copy, and delete media assets within your course collection.
At any point you can create folders to organize the media assets for your course. See Manage Your
Courses in ShareStream MediaManager on page 45 for more information about creating folders within
your course collection.

Move Media
You can move a media asset to another folder in your course collection. Note: This feature does not
apply to Podcasts, which cannot be moved.
1. Select a media asset.
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2. On the Action menu for the media asset, click Move.

You will then be prompted to select the folder within your Course Collection that you would like
to move the media asset to.

3.

Select the folder within your Course Collection, and then click Done.

Copy Media
You can also copy a media asset to another folder in your course collection. Note: Podcasts cannot be
copied.
1. Select the media asset.

©Copyright 2013 ShareStream
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2. On the Action menu, click Copy.

You will then be prompted to select the folder that you would like to send the copy of the media
asset to.

3. Select the folder within your Course Collection, and then click Done.

Delete Media from the Course Collection
To delete a course media asset from the Course Collection:
1. Select the media asset.
2. On the Action menu, click Delete.

The media asset is then deleted from your Course Collection.

©Copyright 2013 ShareStream
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Show or Hide Folders
On the Course Collection tab, you can switch between showing and hiding the folders within your
Course Collection. Click Hide Folders or Show Folders to switch to the other option.

Folders Hidden; Click to Show

Folders Shown; Click to Hide

View Contents of Folders
Click on a folder name to see the media files within that folder. Click Back up one folder to return to the
higher-level folder.

Click to Enter Folder

Folder Contents; Click to Return

See Manage Your Courses in ShareStream MediaManager on page 45 for more information about
creating folders.
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Use the My Workspace Tab
My Workspace is a personal storage location for instructor media. The media assets that you have
uploaded to your My Workspace page will not be viewable by students, until you have added the media
assets in My Workspace to your Course Collection page.
As you learned in the Get Started with ShareStream section beginning on page 1, you can use the My
Workspace tab to upload media assets into ShareStream. You can also tag content with metadata from
My Workspace and add media to your course collection. At any time, you can return to My Workspace
to upload more media files. This section describes the additional tasks you can perform in My
Workspace.
Note: Certain types of media must be uploaded through ShareStream MediaManager. For example, if
you create a podcast or a screen capture of your course lecture, you will need to use MediaManager to
upload those files. See Upload Special Media File Types Through MediaManager on page 51 for more
information.

Upload Media to My Workspace
You can browse your computer’s directory to upload media to the My Workspace page in Pick-n-Play.
To upload a media asset into your My Workspace area in ShareStream:
1. Click the My Workspace tab.
2. Click Upload Media, either the large button to the left of the media player, or the menu option
at the top of the My Workspace tab.

©Copyright 2013 ShareStream
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The Upload popup window opens for you to upload your media asset.

3. Select one of the following options:
 Click the Drop/Click to Select Media File button, and browse to locate and select the media
asset on your computer’s file directory.
 Drag and drop a media asset onto the Drop/Click to Select Media File button. Note: Drag
and drop is not currently supported in the Internet Explorer browser.
4. Enter information about this media asset.
5. Click Add Media.
Your media asset is now uploading to the My Workspace page.

©Copyright 2013 ShareStream
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Progress bars will provide you with real-time updates as the file is being uploaded.

A “Processing” icon appears in the My Workspace gallery until the file is ready for your use.

©Copyright 2013 ShareStream
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Play Media in My Workspace
To play media in your My Workspace tab, select one of the following options:



Click on the Action menu for the media asset, and select Play.
Click on the thumbnail for the media asset, and then use the buttons in the Media Player.

Edit Metadata in My Workspace
To view and edit the metadata for a media asset in the My Workspace tab, select one of the following
options:


Click the More Info link in the Media Player.



Click on the Action menu and select Information.

©Copyright 2013 ShareStream
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The Metadata dialog box will open.

To edit the metadata, click the Edit tab.

On the Edit tab, edit the fields as necessary, and then click Done. The edits you have made to
the media asset’s metadata will appear.
Click the X to close the dialog box.

©Copyright 2013 ShareStream
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Download Media from My Workspace
From the My Workspace tab, you can download the media assets you have uploaded from your
computer.

When you select the Download option from the Action menu, you will see a prompt to open the file with
an application, or save the file to your computer. You can open the file with the appropriate application,
or save the file to view later.

Delete Media from My Workspace
To delete media from My Workspace, follow the steps below:
1. On the My Workspace tab, select the checkbox next to a media asset.
2. Then, click Delete. A dialog box opens to confirm the deletion.
3. Click OK to delete the media asset.

Please note that when you delete media assets from My Workspace, ShareStream deletes the asset only
from your My Workspace page, not from the Course Collection page. Therefore, when you delete
assets from your Workspace, the application will not remove or delete assets that have already been
added to the Course Collection page. To delete files from the Course Collection page, you must select
the Course Collection tab in Pick-n-Play, and delete the asset from the Course Collection page.
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Add Media to Your Course from My Workspace
When you are finished adding metadata and reviewing media in your ‘My Workspace’ area, you will add
the media to your Course Collection.
To add the media asset to your Course Collection, please follow the steps below:
1. On the My Workspace tab, select the checkbox next to the thumbnail for your media asset.
2. Click on Add to Course.

A dialog box opens for you to select a folder destination in your Course Collection.
3. Select the folder you would like to add the media asset to, and then click Done.

4. You will see a confirmation message when the file is added. Click the X to close the popup
window.
5. Click on the Course Collection tab, and you will see the media asset you have added to the
Course Collection.

©Copyright 2013 ShareStream
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Note: You may see a placeholder thumbnail while the media asset is still processing.

When the media asset has completed, you will see it in your Course Collection.
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Collaborate with Your Students
ShareStream Pick-n-Play provides several ways for you to interact with your students on the media
assets in your Course Collection.






Create an online discussion thread with your students about the media assets for your course
using the Commenting tool. See Work with Comments on page 32.
Allow students to send media assets to you through the Dropbox. See Use the Dropbox on page
33.
Receive student media in your Media Inbox. See Receive Student Media in the Media Inbox on
page 36.
Add student media in your Media Inbox to the Course Collections page, so other users in your
course can access it. See Add Student Media to Your Course Collection on page 37.
Share course media outside of ShareStream or the Blackboard Learn system while ensuring that
only users enrolled in your course can access the course media asset that you have shared. See
Share a Media File on page 37.

Work with Comments
You can use Comments to discuss the media assets in your Course Collection with your students.
Comments will be viewable by everyone with access to your course.

View or Hide Comments
You can view or hide comments on your current display.
1. Select a media asset.
Under the media player, you will see the Comments section.

By default, you will be able to view any comments that exist for the media asset.
2. To hide the comments, click Hide Comments.
3. Then, to view comments again, click Show Comments.
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Add Comments
To add comments to a media asset:
1. Select a media asset. Under the media player, you will see the Comments section.
2. Click the Add Comments tab.

3. In the Title text box, add or edit the title of your comment, and then in the Comment text box,
add your comment.
4. Click Add Comments.

Use the Dropbox to Allow Students to Send Media
You can allow students to send media assets to you via the Dropbox feature. Other instructors teaching
the same course can also use the Dropbox. When a student sends media via the Dropbox, it will appear
in the Instructor’s Media Inbox. The Dropbox does not publish media to the course in the Course
Collection page; rather, it publishes the media asset to the Instructor’s Media Inbox in the Pick-n-Play
interface. From the Media Inbox, you can easily add the media assets sent to you by your students to
the Course Collection page.
Note: For best results, students should upload MPEG 4 files to the Dropbox with a resolution that does
not exceed 1280 x 720. Also, students should not send phone-capture videos, as these files often have a
significant amount of dropped frames, which results in playback issues when the file is streamed.
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Enable the Dropbox
First, you will need to enable the Dropbox. Click the Enable Dropbox button.

Then the Dropbox folder icon will appear in Pick-n-Play for both you and your students.

Send Media via the Dropbox
To send media using the Dropbox, do either of the following:



Click the Dropbox icon, and then browse to locate and select a media file from your computer’s file
directory.
Or, drag and drop a file onto the Dropbox icon. Note: Drag and drop is not currently permitted in the
Internet Explorer browser.

The Dropbox Icon will show a spinning wheel and a progress bar to show the progress of the file upload.
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When the upload is complete, the media asset will then appear in the instructor’s Media Inbox.
The first time a media file is sent to you via the Dropbox, the Media Inbox tab will be added to your Pickn-Play interface. You will see text in red showing that you have a New item in your Media Inbox.
Click the Media Inbox tab to view the media asset you have received.

Disable the Dropbox
You can click the Disable Dropbox link, which will remove the Dropbox from the student’s view and
prevent them from sending media to your Media Inbox.

To re-enable the Dropbox, click the Enable Dropbox button again.
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Receive Student Media in the Media Inbox
If students have submitted media to you through the Dropbox, click the Media Inbox tab to view any
added files.
Your Media Inbox link shows how many new media assets you have received. Any media added recently
will appear with Is New! in red text.

You can use the Action menu in the Media Inbox to perform any of these actions:







Set to new to show a media file you have already played as “New” again
Play to view the file in your Media Inbox
Information to see the Title and Contributor for the media asset
Add to course to include the media asset in your Course Collection (see the next section,
Add Student Media to Your Course Collection).
Download to save a copy of the file to your computer
Delete to remove the file from your Media Inbox
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Add Student Media to Your Course Collection
You can add student media to your Course Collection from your Media Inbox.
In the Media Inbox, click on the Action menu for the media asset in the thumbnail gallery and select Add
to course.

Then, everyone with access to your course will be able to see the student-media asset that you have
added to the Course Collection page.

Share a Media File
You can use the Share File link to share media assets outside of the Pick-n-Play interface or your
Learning Management System, but still restrict access to only users enrolled in your course. This option
is popular for sharing media links over emails or posting media to external sites, while still ensuring that
only students enrolled in your course can access the media assets.
Please note that files shared using the Share File link will require the user to authenticate, namely enter
their username and password before they can access the file. This is by design, as it ensures that only
users enrolled in your course are able to access your media.
You can share links to media files in two ways:


Using a Direct Link, also known as “Deeplinking,” which allows you to copy the media asset’s
URL. This URL can be sent to users over email for example.



Using an Embed Code, which creates a link that includes a thumbnail of the media asset within a
frame.

Note: To add a ShareStream media asset directly to a Blackboard Learn course page, the best option is
to use the Mashup Tool, if your institution’s version of the Blackboard Learn system includes the
Mashup Tool rather than the “Share Video” features beneath the player. See the section Add Media
through the Mashup Tool on page 40.
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To share a media asset from Pick-n-Play:
1. Click Share Video under the Media Player.

2. Choose Direct Link and then copy and paste the entire URL.

3. Choose Embed Code to display the code for the link. Select the entire contents of the text box,
copy the code, and paste into the text editor for a web page. On the resulting web page, the
link to the media asset will appear as a thumbnail of the media within a frame.
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4. Click the X to close the Share File box.

Include ShareStream Media in Blackboard Learn
Features
You can use the familiar features of the Blackboard Learn application—such as the Mashup Tool, the
Text Editor, the Assignments, and the Grade Center—to incorporate media stored in ShareStream into
your Blackboard Learn course pages and student assignments.
For example, ShareStream’s integration with the Blackboard platform allows instructors to:





Add media assets stored in ShareStream directly to Blackboard Learn web pages for your course.
For more information, see Add ShareStream Media to a Course Page, below.
Create assignments in the Blackboard Learn Assignment Tool that allow students to use
ShareStream’s ability to upload, submit and stream media directly from a Blackboard Learn
assignment. For more information, see Receive Student Media through the Assignment Tool on
page 42.
Assess and grade your students on the media they have submitted to you. See Evaluate Student
Media on page 45.

Add ShareStream Media to a Course Page
ShareStream’s integration with the Blackboard Learn platform allows instructors to add media stored in
ShareStream directly to course web pages right from the Blackboard Learn interface.
You can add media directly to a course web page for your course using either of these Blackboard Learn
features:



The Mashup Tool, which allows instructors to search for, browse and add the media assets in
your ShareStream Course Collection to a Blackboard Learn page.
The Text Editor, where instructors can also add ShareStream media to a course page while
creating the page in the Blackboard application.
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Add Media through the Mashup Tool
You can display course-media assets directly from a Blackboard Learn web page through ShareStream’s
Media Publishing Tools, which allow you to easily add media to a specific Blackboard Learn page.
Note: If your institution uses a release of the Blackboard Learn platform that is earlier than Blackboard
Learn 9.1, the Mashup Tool will not be available in your system. As an alternative, ShareStream
provides the “Show LMS Embed Code” feature in ShareStream MediaManager. See Share Files in
Blackboard Learn Pages without the Mashup Tool on page 61.
To add ShareStream media from your course collection to a course web page, use the Blackboard Learn
Mashup Tool.
1.
2.
3.
4.

Navigate to a course for which you are an instructor.
Click the Content option in the course menu.
Click the Build Content tab. Under Mashups, select ShareStream Mashup.
Search for the media asset(s) that you would like to add, in either of the following ways:
 Use the Search box and any of the filter options in the dropdown menu, and then click GO.
Then select the media in the search results and click Add Media.



Or, click on Display All Files to browse all of the media assets for this course.
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Browse the media assets, check the file you want, and click Add Media.

The selected media assets will then appear in the Blackboard Learn Content area.

Add Media Using the Text Editor
You can also use ShareStream’s Mashup Tool integration directly from the Blackboard Learn Text Editor
in by following the steps below:
1.
2.
3.
4.
5.

Go to your Course Page for a course for which you are the instructor.
Click Content in the course menu.
Click the Build Content menu and select Item.
In the Text Editor toolbar, click Show More (the double down-arrow icon).
Click the Mashup menu and select ShareStream Media.
Note: If you do not see ShareStream Media in the Mashup menu as shown above, you can
customize your Blackboard Learn Text Editor display to enable the ShareStream Mashup within
the Text Editor. See Add Mashup Tool to Text Editor on page 60.

5. Search for the media asset(s) that you would like to add in one of the following ways:
 Use the Search box and any of the filter options in the dropdown menu, and click GO.
Select the file you want from the Search Results, and click Add Media.
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Click on Display All Files.
Then browse and select media assets in your Course Collection and click Add Media.

The media asset or assets that you have added will then appear in your Course Page in the Text Editor,
and will be presented to your students on your Course Page when you publish the Blackboard Learn
page.

Receive Student Media through the Assignment Tool
ShareStream is integrated with the Blackboard Learn Assignment Tool and the Grade Center, so that you
can grade student media. You can request and receive media assignments from students through the
Assignment Tool, and then evaluate their media assignments in the Grade Center.

Request Media in an Assignment
Use the Blackboard Learn interface to request media from students using the Assignments option.
1.
2.
3.
4.

Navigate to a course for which you are an instructor.
Click the Assignments option in the course menu.
Click the Assessments tab. Select ShareStream Media.
Enter the Blackboard Learn fields for your assignment, and click Submit.

Your assignment will then appear on the Assignments page that your students can see.
You can use the Blackboard Learn options to edit your assignment.

Student View: Upload Media to an Assignment
After you have created a media assignment for your students, the student view will show your
assignment in the Assignments list.
Your students will follow the steps below to upload their media assignments and send these files to you,
which you can conveniently access in the Blackboard Learn Grade Center.
1. First, the student will go to the Assignments page and click on your assignment.
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2. Then the student can upload a media file in response to your assignment.

A progress bar will let the student know the media asset is uploading.
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A message then appears when the file has been transferred into ShareStream.

3. The student must click Submit to complete the process of submitting the media asset for your
assignment.

A message confirms that the submission is complete.
After the student has submitted media for an assignment, you can evaluate the media asset in the
Grade Center, as shown in the next section.
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Evaluate Student Media in the Grade Center
Directly in the Blackboard Learn Grade Center, you can access and grade the media assets that were
submitted to you by your students via ShareStream’s integration with the Assignment Tool.
Use the Blackboard Learn Grade Center to assess your students’ work.
1.
2.
3.
4.

Navigate to a course for which you are an instructor.
Click the Grade Center option in the Course Management menu.
Select the option you want: Needs Grading, or the Full Grade Center.
In the list of student media, click the menu and select the option to grade the media
assignment: Grade All Users or Grade Anonymously.
5. On the Grade Assignment page for the media asset, click Play Media.
ShareStream media assignments are handled in the same way as assignments submitted directly to the
Blackboard Learn application, so you will be able to grade ShareStream media assignments and use the
features in the Grade Center just as you would for a typical assignment.

Manage Your Courses in ShareStream MediaManager
MediaManager is the administrative application of the ShareStream Video Platform for education.
ShareStream MediaManager will present you with the same media and data (namely, metadata that you
have entered about your media assets, Course Collections and folders that you have created, etc.) as
ShareStream Pick-n-Play; however, its Collection Management interface is designed for performing
administrative tasks, whereas Pick-n-Play’s interface is designed specifically for instruction.
From MediaManager, instructors can perform Collection Management tasks, such as organizing media
assets for your Course Collection into folders and subfolders; creating video clips from whole works; and
using ShareStream’s media publishing tools. You can also use MediaManager to upload special file
types, such as podcasts, closed-caption files, and composite media.

Edit a Course Collection
By default, the Course Collection folder is named with the Course ID used by the Blackboard Learn
system. In ShareStream MediaManager, you can rename the Course Collection to be more intuitive,
such as the official course title.
1. Go to the Course Home Page for a course for which you are the instructor.
2. On the Course Home Page, click Tools in the course menu.
3. On the Tools page, click ShareStream MediaManager.
ShareStream MediaManager opens in the Blackboard Learn window and will display the
ShareStream media assets in the Course Collection for your course. By default, the original
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course title is the CourseID stored in your system. You can edit the course title so that it is easily
recognizable by students, such as the full name of your course.

4. To edit the Course Collection, right-click (ctrl-click for Mac users) on the course title, or click on
the Collection menu and select Edit Collection.
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5. Edit the Course Collection information, to change the title, instructor name, or description.

Organize Your Course Collection
You can create folders and subfolders in MediaManager to organize your media assets. For example,
you can create folders for each week of your course and add the media assets assigned for a particular
week to the week’s folder for each week in your syllabus. To accomplish this, please follow the steps
below:
1. Right-click (ctrl-click for Mac users) on the course name.
2. Select Add Collection.
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3. Enter the title and other information for the new Course Collection (which will appear as a
subfolder under your main Course Collection).

4. Continue to create subfolders by repeating the previous steps for each folder.
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5. The folders and subfolders that you create in MediaManager will populate in Pick-n-Play.

Then you can move or copy your existing media assets into the new folders, or add media assets directly
into the new course folders from My Workspace. See Organize Your Media in the Course Collections
Page on page 20.

Create a Video Clip
In ShareStream MediaManager, course instructors are able to create custom segments from streaming
video assets and make these segments available to students. Follow these steps for creating video clips.
1. Right-click (ctrl-click for Mac users) on the asset in the center page of the MediaManager
interface and, from the drop-down menu, select Create Video Clips.

2. Play the clip to the desired ‘mark-in’ point of the first clip, and then click Pause when you have
reached the desired point.
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3. Click the mouse in the Start-time text box at the bottom of the window, and click on the
progress bar for the video player to have the “mark-in” point you just created populate in the
start-time box.

4. Click in the End-time text box. Continue playing the video to the ‘mark-out’ point, click Pause,
and then click on the progress bar to have the “mark-out” point populate in the end-time box.

5. In the Clip Name text box, enter a name for the clip.
6. Click Save to complete the process.
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Upload Special Media File Types Through
MediaManager
In certain cases, you’ll need to use ShareStream MediaManager to upload special media file types.
These cases include:





Downloadable Media
Podcast Media
Closed-caption files
Composite media files (or zipped files), typically generated through screen-capture tools

Since these file types cannot be transcoded—converted into a different file type—you will need to
upload them through MediaManager instead of through Pick-n-Play.
See the Appendix: Supported ShareStream Platform Input Formats on page 62 of this guide for a table
of file formats supported in MediaManager (as well as in Pick-n-Play).

Upload Media as Downloadable
Only assets that have been checked as “Downloadable” will allow users to download the asset from
ShareStream’s applications, namely Pick-n-Play and MediaManager. This is by design, as most content is
not intended to be downloadable by default.
First be sure the file is of a downloadable type (see the table in the Appendix: Supported ShareStream
Platform Input Formats).
Follow the steps below to upload a media asset that may be downloaded by the users in your course:
1. In MediaManager, right-click (ctrl-click for Mac users) on the folder and select Add Asset.
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2. Enter the Asset Required Metadata.

3. Click on the Asset Media File(s) tab. Select the file from your computer’s file directory and
enter the filename in the box in the UPLOAD DOWNLOADABLE FILE section of the popup
window.

4. Check Downloadable as a delivery option under Edit Asset in MediaManager.
5. Click Save Asset.
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Note: You can also make existing media downloadable, provided a downloadable file type has been
ingested for the asset. To accomplish this, right-click (ctrl-click for Mac users) on the media asset in
MediaManager, click Edit Asset, and check Downloadable in the Asset Media File tab as shown above.

Upload Podcasts
You can also upload podcasts to your Course Collection through MediaManager.
You must first create a folder in MediaManager with a name ending in “-podcast” and check the options
to upload podcasts to that folder.
1. In MediaManager, right-click (ctrl-click for Mac users) on the folder name and select Add
Collection.

2. In the Collection Information popup window, enter a folder name ending in “-podcast” and
enter the Course ID (which you can see in the top-level Course Collection folder if you right-click
and select Edit Collection).
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3. Right-click (or ctrl-click) on the podcast folder and select Add Asset.

4. In the Asset Metadata popup window, click on the Asset Media File(s) tab. In the Upload
Downloadable File section of the popup window, select the Choose File button and then select
your podcast file from your computer’s file directory. Make sure Downloadable Audio is
selected as the file type, and Downloadable is checked.
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5. Click Save Asset.
Then, when the viewer selects media stored in the –podcast folder, ShareStream will automatically
launch iTunes, ask the user to authenticate (i.e., enter his or her username and password) and, after the
user has successfully authenticated, sync content into iTunes

Upload Closed-Caption Files
MediaManager enables instructors to upload user-generated subtitle files, associate the subtitle file to
an asset, and playback the subtitle file with synchronization between the subtitle text and time codes.
ShareStream supports .srt file format (SubRip Text) for closed-caption files.
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Follow the steps below to upload a subtitle file that corresponds to a media asset stored in
ShareStream:
1. In MediaManager, Right-click (ctrl-click for Mac users) on an asset and select Add ClosedCaption File.

2. Click on the Choose File button from the Upload Closed Caption File popup window.
3. Browse your computer’s file directory and select the .srt subtitle file that you would like to add
to the media asset.
4. Click OK.
After these steps are completed for an asset, captions will appear during media playback in
ShareStream’s MediaManager and in Pick-n-Play applications.

Upload Composite Media Files
ShareStream MediaManager enables the ingestion and playback of special, composite media file types,
typically lecture capture files that can combine audio, video, screen captures, presentations, and other
multimedia types.
A lecture capture application often produces a .zip file of a folder containing all the media files that
comprise the lecture. The folder must contain an index.html or index.htm file, generated by the lecture
capture software, that has links to the rest of the media in the folder. ShareStream typically has the
ability to ingest and playback the media files contained in the zipped file.
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To upload a composite media file:
1.

In MediaManager, Right-click (ctrl-click for Mac users) on a course folder and select Add Asset.

2. In the Asset Required Metadata tab, go to the Digitized File Format section and select Zipped
Media.
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3. Click the Asset Media File(s) tab. In the UPLOAD STREAMABLE FILE text box, enter the .zip file
from your computer’s directory. Check Streamable at the bottom of the window.

4. Click Save Asset.
Then, anyone with access to your course will be able to play the media files contained in the composite
media folder. When the viewer clicks to play the composite media, a browser window will open to
display the media assets.
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Enable Additional ShareStream Integration Points
with the Blackboard Learn Platform
You can easily enable additional integration points between ShareStream and your Blackboard Learn
system including:



Enable the ShareStream Course Module on your Course Home Page, provided you have the
Blackboard Learn Community Engagement module at your institution.
Add the ShareStream Mashup Tool to the Text Editor.

Add Course Module
If your institution has the Blackboard Learn Community Engagement module, you can add a
ShareStream Course Module to your Course Home Page.
To add the ShareStream Course Module:
1. Navigate to your Blackboard Learn Course Home Page.
2. Click on Add Course Module.
3. Search for ShareStream, select the appropriate ShareStream option and click Add.
Then the ShareStream Course Module will appear on your Course Home Page, where you can drag and
drop the module into place. You can Show or Hide the folder panel.
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The View All Course Media link will take you directly into ShareStream Pick-n-Play where you can add
media to your course collection.

Add Mashup Tool to Text Editor
In order to add ShareStream media directly to the Blackboard Learn web pages for your course as
described in the section Add Media Using the Text Editor on page 41, you may first need to enable the
ShareStream Mashup tool for the Text Editor.
To determine if your institution already has the ShareStream Mashup tool in the Text Editor, and then
enable it if you will need to:
1.
2.
3.
4.

Go to your Course Home Page.
Click the Build Content menu and select Item.
In the Text Editor toolbar, click Show More (the double down-arrow icon).
If you do not see the Mashup item in the bottom row of the icons, you will need to enable the
ShareStream Mashup tool.
5. To accomplish this, click to expand the Customization option in the Blackboard Learn Course
Management menu.
6. In the Customization menu, click Tool Availability.
7. Scroll down to the ShareStream options and check ShareStream Mashup (in TextEditor).
Then you will see the ShareStream Mashup option in the Text Editor.
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Share Files in Blackboard Learn Pages without the Mashup
Tool
If your institution uses a release of the Blackboard Learn platform that is earlier than Blackboard Learn
9.1, the Mashup Tool will not be available in your system. As an alternative, ShareStream provides the
“Show LMS Embed Code” feature in ShareStream MediaManager.
If the Blackboard Learn system at your institution does not include the Mashup Tool, you can still add
media assets stored in ShareStream directly to Blackboard Learn pages without requiring the user to reauthenticate (namely, enter their username and password again).
To add a media asset so that any user logged into the Blackboard Learn system who has access to your
course can view the media asset without being prompted to authenticate, go to ShareStream
MediaManager and use the “LMS embed code” feature by following the steps below:
1. In MediaManager, right-click (ctrl-click for Mac users) on the media asset and select Show LMS
embed code.

2. Copy the LMS embed code into a Blackboard Learn course page.
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Appendix: Supported ShareStream Platform Input
Formats
ShareStream Pick-n-Play and MediaManager support uploading the predominant media input formats as
specified in the tables below.
Both Pick-n-Play and MediaManager have a 2 GB file size limitation. If you have files greater than 2 GB,
please contact your ShareStream system administrator for assistance.

Pick-n-Play Supported Input File Formats

Format

Streamable

Downloadable

Comments

.avi (Audio + Video)

X

X

Audio Video Interleaved

.m4v (Video)

X

X

Advanced Audio Coding

.mov (Video)

X

X

QuickTime Video

.mp3 (Audio)

X

X

MPEG-3 Audio

.mp4 (Audio)

X

X

MPEG-4 Audio

.wma (Audio)

X

X

Windows Media Audio

.wmv (Video)

X

X

Windows Media Video
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MediaManager Supported Input File Formats

Format
.mp3 (Audio)

Streamable

Downloadable

X

X

MPEG-3 Audio

X

MPEG-4 Audio

.m4a (Audio)

Comments

.swf (Video)

X

Adobe Flash File format

.flv (Audio + Video)

X

Flash Audio + Video

.mp4(h264) (Video)

X

H.264/MPEG-4 Video

.m4v(h264) (Video)

X

H.264/MPEG-4 AVC Video

.mp4 (Audio)

X

MPEG-4 (QuickTime Audio)

.m4v (Video)

X

MPEG-4 (QuickTime Video)

Please contact ShareStream Support at support@sharesteam.com with any questions.
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